Teradici PColP Remote Workstation Card Agent for Windows Documentation

Teradici PColP Remote Workstation Card Agent for
Windows Documentation

This documentation is intended for administrators who are installing the Remote Workstation Card
Agent for Windows as part of a Teradici Remote Workstation Card system. It assumes thorough
knowledge of conventions and networking concepts, including firewall configuration.

Although many agent features and settings can be configured using the Windows user interface,
some administrative tasks require use of Windows command line tools. Users should be familiar
with both ecmd and PowerShell.

About the PColP Remote Workstation Card Agent for Windows

The PColP Remote Workstation Card Agent for Windows introduces Teradici brokering to a
Teradici Remote Workstation Card deployment, allowing the desktop to be managed by Teradici
Cloud Access Manager or by third-party brokers like Leostream.

A complete PColP Remote Workstation Card deployment includes these components:
- A physical host machine, which provides the desktop to remote clients. See System
Requirements for more information.
+ A PColP Remote Workstation Card installed on the host machine.
+ The PColP Remote Workstation Card software installed on the host machine.

+ The Remote Workstation Card Agent for Windows installed on the host machine.

About PColP Licensing

When the Remote Workstation Card Agent for Windows is installed, the Remote Workstation Card
can be licensed using a Cloud Access Software license. With this flexibility, you can conveniently
move to Cloud Access Software and virtual solutions when you are ready, and without changing
licenses.
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What's New in This Release

What's New in This Release

Release 19.11.0 of the Remote Workstation Card Agent for Windows includes the following
enhancements:

- Security updates and bug fixes
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System Requirements

System Requirements

The Remote Workstation Card Agent for Windows depends on the following system capacities
and capabilities:

Supported Instance Types

The Remote Workstation Card Agent for Windows requires a physical machine with a PColP
Remote Workstation Card installed.

Host Instance Requirements

Global instance requirements

Operating Systems
+ Windows 10 1709, 1803, 1809 (64-bit Professional and Enterprise)

+ Windows Server 2016 (single-user only)

+ NET 4.5

Remote Host Memory At least 2GB of RAM is required on the host desktop.
The agent should have at least 572MB of available memory.

Remote Host CPUs At least 2 CPUs are required on the host desktop.
Processors must support Streaming SIMD Extensions (SSE) 4.2.
To use PColP Ultra, processors must support the AVX2 instruction set.

Network Ports The following ports must be open on the host desktop:

- TCP 443
- TCP 4172
- UDP 4172
- TCP 60443

Storage At least T00MB for installation and T00MB for logging are recommended.
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PColP Remote Workstation Card Agent for
Windows Installation Guide

Before you proceed with installation, a few prerequisites must be met.

Prerequisites

These instructions assume you have already built the remote desktop machine, and that the
machine meets the agent's requirements.

A few other things to confirm before proceeding:

* You should have already installed the Host Software for Windows on the desktop machine.

+ The desktop machine requires the following ports to be open: TCP 443, TCP 60443, TCP 4172,
and UDP 4172.

+ You should be able to run applications as an administrator.

+ The PColP Agent must be able to execute PowerShell scripts. If your PowerShell execution
policy set to Restricted, the execution policy will be automatically changed so installation can
proceed. If the agent cannot execute PowerShell scripts or change the execution policy, the
installation will fail.

+ On Windows 2008 R2 or Windows 7 desktops, the PColP Agent must be able to simulate
Secure Attention Sequence. SAS is enabled by setting a Windows GPO variable as described
here.

- If you are using a PColP Local License Server, you'll need to know its URL and port numbers.

Installation Overview

Once your prerequisites are in place, you can proceed with installation. Here's a brief overview of
the process:

1. Temporarily connect a physical display, mouse, and keyboard to the machine for installation.
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Installation Overview

2. Download or transfer the PColP Remote Workstation Card Agent for Windows installer to the
system.

3. Install the PColP Agent using one of these methods:
+ Using the installer's setup wizard for a guided, interface-driven process, or
- Silently using a script

4. If required, configure the agent software.

5. Disconnect physical display, mouse, and keyboard.

6. Connect to the desktop using a PColP client.

If you're ready to start, proceed to installation.
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Installing the PColP Remote Workstation Card Agent for Windows

Installing the PColP Remote Workstation Card
Agent for Windows

Download the Remote Workstation Card Agent for Windows
Installer

The Remote Workstation Card Agent for Windows installs at the system level and is available to all
users. You must have administrator privileges to install it. You can download the installer directly
onto the machine, or download it separately and transfer it yourself.

The installer can be downloaded here.

Install or Update the Remote Workstation Card Agent for
Windows

Once the installer is present on the desktop, you can run the setup wizard or install it silently using
a script. The procedure is the same for new installations and system upgrades.

Installing the Remote Workstation Card Agent for Windows using the Wizard

If you're installing the Remote Workstation Card Agent for Windows via the Windows interface and
would prefer to use a graphical interface and guided setup, use the Remote Workstation Card
Agent for Windows setup wizard.

To install the Remote Workstation Card Agent for Windows using the setup wizard:

1. Temporarily connect a physical display, mouse, and keyboard to the machine for installation.

2. Navigate to the Remote Workstation Card Agent for Windows installer file and launch it. The
setup wizard will appear.

3. Select an installer language and click OK.
4. Click Next at the welcome screen.

5. Review and accept the license agreement by clicking | agree.
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Scripted Installations

6. Specify an installation directory and click Install.

By default, the software will be installed inthe C:\Program Files

(x86) \Teradici\Remote Workstation Card Agent for Windows directory.
7. Provide your licensing information on the License Registration screen.

Type or paste a registration code in the Registration code field and click Next for the proxy
settings screen.

6 Important: Local license server users

If you are using a local PColP License Server, do not enter a registration code here. Select Not now and then click
Next instead. You will configure your license server information later.

- If you use a proxy server to access the internet, select Use a proxy server for Internet
connection and specify the address and port numbers of the proxy server, then click Next to
register the license.

« If your system does not use a proxy server, leave this screen unchanged and click Next to
register the license.

8. The Windows desktop must be rebooted to complete installation; you can choose to do that
now, or do it yourself later. Some features may not work until the system is restarted.

9. Click Finish to exit the installer.

10. If you skipped license registration, complete registration by following one of the procedures
listed here.

11. Disconnect the monitor, keyboard, and mouse.

Once the Remote Workstation Card Agent for Windows is installed and licensed, you can configure
it or connect to it with a PColP client.

Scripted Installations

The Remote Workstation Card Agent for Windows can be installed on the desktop
programmatically, without using a graphical interface. The installation will proceed silently and the
system will reboot when finished.

Scripted installation requires access to the Windows Command Prompt or PowerShell.
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Scripted Installations

To install the Remote Workstation Card Agent for Windows via a script:

1. Temporarily connect a physical display, mouse, and keyboard to the machine for installation.
2. Copy the agent installer file to the desktop.
3. Run the agent installer using one of the following methods:
+ Windows BAT: Open a Windows command line tool and enter the following:
start /WAIT <path_to_installer> /S /NoPostReboot
echo %ERRORLEVEL%
..wWhere <path_to_installer> is the system filepath of the installer file.
+ Windows PowerShell: Open a PowerShell window and enter the following:
Sprocess = Start-Process -FilePath <path_to_installer> -ArgumentlList

"/S /NoPostReboot _?<path_to_installer>" -Wait -PassThru
$process.ExitCode

..where <path_to_installer> is the system filepath of the installer file. Note that this
argument is used twice!

Both methods will return one of these process return codes:

code description

0 success

1 installation aborted by user (user cancel)
2 installation aborted due to error

1641 success, reboot required

4. If you are using Cloud Licensing, register the Remote Workstation Card Agent for Windows's
license by running the pcoip-register-host.ps1 script:

C:\Program Files (x86)\Teradici\Remote Workstation Card Agent for
Windows\pcoip-register-host.ps1 [-ProxyServer <String>] [-ProxyPort <String>]
-RegistrationCode <String> [<CommonParameters>]
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Register a License After Installation

Where:
-RegistrationCode sets the registration code to use.
-ProxyServer sets the address of your proxy server, if you have one.

-ProxyPort sets the port number of your proxy server, if you have one.

6 Important: PowerShell execution policy

PowerShell scripts must be permitted to run on your machine. If your execution policy prevents pcoip-register-
host.ps1 from running, you can temporarily enable PowerShell script execution with the following command:

powershell.exe -InputFormat None -ExecutionPolicy Bypass -Command .\pcoip-register-
host.ps1

Once the Remote Workstation Card Agent for Windows is installed and licensed, you can configure
it or connect to it with a PColP client.

Register a License After Installation

In most cases, a PColP license is registered during installation. If you are using a local license
server, or if you skipped registration during installation, you can register your agent using the
methods described next.

- Registering with Teradici Cloud Licensing: If you are using Teradici's Cloud Licensing service (most
systems use this method), you can register the agent using the PColP control panel or via a
PowerShell script.

- Registering with a Local License Server: If you are serving licenses with your own license server,
your registration method depends on your brokering environment. For complete information
and instructions, see Licensing Remote Workstation Card Agent for Windowss with a Local
License Server.
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Licensing The Remote Workstation Card Agent for
Windows

The Remote Workstation Card Agent for Windows must be assigned a valid PColP session license
before it will work. Until you've registered it, you can't connect to the desktop using a PColP client.

You receive a registration code when you purchase a pool of licenses from Teradici. Each
registration code can be used multiple times; each use consumes one license in its pool.

2" Note: Registration code format
Registration codes look like this: ABCDEFGH12@AB12-C345-D67E-89FG
PColP agent license registrations are managed automatically by Teradici's Cloud Licensing

service. If necessary, you can manage them yourself, using your own locally-installed
PColP license server instead.

If you need to purchase licenses, contact Teradici.

Using Teradici Cloud Licensing

To use Cloud Licensing, all you need to do is provide a registration code for each Remote
Workstation Card Agent for Windows in your deployment (the same registration code can be used
multiple times).

© 2019 Teradici
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Register or Renew a PColP License With the PColP Control Panel

6 Whitelist network blocks for Teradici Cloud Licensing

If you are using Teradici Cloud Licensing, you will need to whitelist the following:

« teradici.flexnetoperations.com

+ teradici.compliance.flexnetoperations.com
Alternatively, you can also ensure the following network blocks are whitelisted:

+ Production: 64.14.29.0/24
- Disaster Recovery: 64.27.162.0/24

The following network blocks are not currently in use, but may also be used in the future:

+ Production: 162.244.220.0/24
- Disaster Recovery: 162.244.222.0/24

The Windows setup wizard collects this registration code during installation. If you're already
registered your PColP agents, there's nothing more to do here. If you've already installed the PColP
agent software but have not registered it yet, you can register post-installation using the PColP
Control panel or via a PowerShell Script.

Register or Renew a PColP License With the PColP Control Panel
Use this method to register or renew an installed PColP agent using the Windows user interface.
To provide the registration code via the PColP Control Panel:

1. Connect to the desktop using a physical keyboard, mouse, and display (if you're renewing a
license that is still active, you can use a PColP session to do this instead).

2. Open the PColP control panel by clicking L1 inthe system tray and select Licensing from the
pop-up menu:

Updates

Support
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Register or Renew a PColP License With PowerShell

The PColP Control panel appears with the licensing tab enabled.

3. Provide the registration code in the registration code field.

Register or Renew a PColP License With PowerShell

Use this method to register a PColP agent using Windows PowerShell. You can do this during a
scripted installation, or at any time after installation.

To provide the registration code via the Windows PowerShell script:

1. Connect to your dekstop using a physical keyboard, mouse, and display.
2. Runthe pcoip-register-host.psl script:
C:\Program Files\Teradici\PCoIP Agent\pcoip-register-host.ps1 [-

ProxyServer <String>] [-ProxyPort <String>] -RegistrationCode <String>
[<CommonParameters>]

Where:
-RegistrationCode sets the registration code to use.
-ProxyServer sets the address of your proxy server, if you have one.

-ProxyPort sets the port number of your proxy server, if you have one.

6 Important: PowerShell execution policy

PowerShell scripts must be permitted to run on your machine. If your execution policy prevents pcoip-register-
host.ps1 from running, you can temporarily enable PowerShell script execution with the following command:

powershell.exe -InputFormat None -ExecutionPolicy Bypass -Command .\pcoip-register-
host.ps1

Licensing PColP Agents With a Local License Server

In deployments where PColP agents cannot access the internet, or where cloud-based licensing is
not permitted or desired, a local PColP License Server can be used instead. The PColP License
Server manages PColP session licenses within your private environment.

© 2019 Teradici
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Brokered Environment Licensing

Configuring PColP agents to use a local license server is done in one of two ways, depending on
whether your deployment uses a PColP Connection Manager, or whether your PColP clients
connect directly to PColP agents.

Brokered Environment Licensing

In brokered deployments, the license server address is configured in the Connection Manager,
which passes it through to its managed PColP agents.

The Connection The Connection The PColP agent

Manager is configured Manager passes the communicates directly with

with the local license address to all the license server, using the

server's address managed PColP address inherited from the
agents connection manager

h_|

Client Connection PColP License
Manager Agent Server

When using a Connection Manager, the license server address is only configured once no matter
how many PColP agents are behind the Connection Manager.

To set the License Server URL in the Connection Manager:

1. On the Connection Manager machine, use a text editor to open /etc/ConnectionManager.conf.
2. Setthe LicenseServerAddress parameter with the address of your local license server:

* http:// {license-server-address} : {port} /request
3. Save and close the configuration file.

4. Restart the Connection Manager.
Verifying Your Brokered Licensing Configuration

To verify your system's licensing configuration, run the pcoip-validate-license.ps1 PowerShell
script on the PColP Agent machine. The script will ping the license server and attempt to retrieve
information on an available license:

© 2019 Teradici
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Unbrokered Environment Licensing

C:\ProgramFiles(x86)\Teradici\PCoIPAgent\pcoip-validate-license.ps1 -
LicenseServerUrl <license-server-address> [-ThroughProxyServer <proxy-server-
address>] [-ProxyPort <proxy port>]

Where <license-server-address> isthe address of the license server to ping, formatted as
http:// {license-server-address} : {port} /request

If the license server is behind a proxy server, provide the proxy information via the
-ThroughProxyServer and -ProxyPort parameters.

If successful, the response will show that a valid license was found on the license server, and its
expiration date.

If the connection is unsuccessful, investigate the following possibilities:

+ The license server address is incorrect, or formatted incorrectly.
+ The license server is inaccessible.

+ There are no available licenses on the license server. pcoip-validate-license.ps1 will only
return a positive response if there is at least one available session license.

- If you have only one license on the license server and run pcoip-validate-license.psT
from a PColP session, the command will fail because you are currently using the single
license. In this scenario, disconnect your PColP session and try again from an RDP session
instead.

Unbrokered Environment Licensing

In direct, or unbrokered, deployments, each Remote Workstation Card Agent for Windows is
configured with the license server address via a GPO variable. When a client initiates a new
PColP session, the Remote Workstation Card Agent for Windows uses its local configuration to
communicate with the license server.
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Unbrokered Environment Licensing

The local license
server address is set
by configuring a GPO

variable on the agent
machine

The PColP agent
communicates directly with
the License Server, using the

address set in the local GPO
variable
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Local license validation using a PColP Windows agent and a direct (unbrokered) connection

Each Remote Workstation Card Agent for Windows in your environment must be individually

configured with the license server's URL.

To configure the License Server URL on the PColP Agent machine:

1. Open the Local Group Policy Editor on the agent machine:

a. Press + r toopen the run dialog

b. type gpedit.msc and press Enter |

2. If you have not already imported the Teradici GPO Administrative Template, import it now:

a. Navigate to the Local Computer Policy > Computer Configuration > Administrative

Templates directory.

b. Right-click the Administrative Templates folder and select Add/Remove Templates from the

context menu.

c. Click Add and navigate to the following directory:

C:\Program Files

d. Select pcoip.adm, and click Open and then Close.

(x86) \Teradici\PCoIP Agent\configuration

3. Navigate to Computer Configuration > Administrative Templates > Classic Administrative
Templates (ADM) > PColP Session Variables > Overridable Administrative Defaults.

The list of configurable PColP settings will appear in the right panel.

4. Open the Configure the license server URL variable.

5. Select the Enabled option.

© 2019 Teradici
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Unbrokered Environment Licensing

6. Enter the License Server URL in the option field and click OK. The URL formatis http://

{license-server-address} : {port} /request.
Verifying Your Unbrokered Licensing Configuration

To verify your system's licensing configuration, run the pcoip-validate-license.ps1 PowerShell
script. The script will ping the license server using the local GPO configuration and attempt to
retrieve information on an available license:

C:\ProgramFiles(x86)\Teradici\PCoIPAgent\pcoip-validate-license.ps1

If successful, the response will show that a valid license was found on the license server, and its
expiration date.

If the connection is unsuccessful, investigate the following possibilities:

+ The license server address is incorrect, or formatted incorrectly.
+ The license server is inaccessible.

+ There are no available licenses on the license server. pcoip-validate-license.ps1 will only
return a positive response if there is at least one available session license.

- If you have only one license on the license server and run pcoip-validate-license.psT
from a PColP session, the command will fail because you are currently using the single
license. In this scenario, disconnect your PColP session and try again from an RDP session
instead.
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Updating the Remote Workstation Card Agent for
Windows

To install an update:

To update the Remote Workstation Card Agent for Windows, copy the new installer file onto the
host machine and run it in place, either via the installation wizard or silently via command line.

© 2019 Teradici
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Unisntalling the Remote Workstation Card Agent
for Windows

The Remote Workstation Card Agent for Windows can be uninstalled using the Windows Control
panel, or by running the uninstall utility provided in the agent's installation directory.

In either case, you should disconnect any active PColP sessions and then connect to the machine
as an administrator with a physical keyboard, mouse, and display.

+ To uninstall using the Windows Control Panel: Open the Windows Control Panel, navigate to
Programs > Uninstall a program, select the Remote Workstation Card Agent for Windows from

the list, and click uninstall.

+ To uninstall using the provided utility: Run the executable found at C: \Program Files

(x86) \Teradici\PCoIP Agent\uninst.exe,
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Configuring the PColP Agent

Configuring the PColP Agent

You can configure the PColP agent, and optimize PColP protocol behavior for local network
conditions, by adjusting Windows GPO variables.

The variables are in admx template files, which are imported automatically by the agent installer.

2" Template files on domain controllers are not automatically installed

Template files are not automatically installed on domain controllers. You must manually import the files into the

domain controller's Group Policy Editor.

Modifying PColP GPO Variables

All of the PColP settings can be configured using this procedure. The configurable settings are

described in the following section.
To modify a PColP session variable:

1. Open the Local Group Policy Editor on the agent machine:
a. Press + r toopen the run dialog
b. type gpedit.msc and press Enter |
2. Inthe left pane, navigate to Administrative Templates and then to PColP Session Variables.
The variables you can configure appear in the right pane.

3. Double-click the PColP variable you want to configure to open the variable's configuration

window, then:
a. Select Enabled to enable the PColP setting.
b. Configure any parameters that are available for the setting.
c. Click OK to close the variable's configuration window.
4. Repeat step 3 until all variables have been set.

5. Close the Local Group Policy Editor.
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Modifying PColP GPO Variables

2" Note: Changes require a new PColP connection

Changes take effect on the next PColP connection to the desktop.
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Security Certificates in PColP Agents

PColP requires a certificate to establish a session. By default, PColP agents generate a self-signed
certificate that secures the PColP session. Each component in the PColP system can generate
these self-signed certificates, which will automatically work together without requiring any
configuration.

You can, if needed, create and deploy your own custom certificates instead of relying on Teradici's
self-signed certificates. This section explains how to create and implement custom certificates.

Using Custom Security Certificates

You can use OpenSSL, Microsoft Certification Authority, or a public certificate authority (CA) of
your choice to create your certificates. If you are not using OpenSSL, consult your certificate
authority's documentation for instructions on creating certificates in a Windows Certificate Store-
compatible format.

The procedures is this section use OpenSSL to generate certificates that will satisfy most security
scanner tools when the root signing certificate is known to them.

Caution: Certificates are stored in the Windows Certificate Store

Certificates are stored in the Windows certificate store. If you have old certificates that are stored on the host, they
should be deleted to avoid conflicts or confusion.

Custom Certificate Guidelines

If you choose to use your own certificates, follow these general guidelines:

+ Save your root CA signing certificate in a safe place for deployment to clients.
+ Back up private and public keys to secure locations.

+ Never store files created when generating keys or certificates on network drives without
password protection.
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Pre-session Encryption Algorithms

+ Once certificates have been deployed to the Windows certificate store, the files they came
from are no longer needed and can be deleted.

+ Standard automatic tools, such as Automatic Certificate Enrollment and Group Policy, can be
used for deploying automatically generated certificates. Both Automatic Certificate Enrollment
and Group Policies are implemented through Active Directory. See MSDN Active Directory
documentation for more information.

Pre-session Encryption Algorithms
Connections are negotiated using the following supported RSA cipher suites:

« TLS_ECDHE_RSA_WITH_AES_256_GCM_SHA384
+ TLS_ECDHE_RSA_WITH_AES_128_GCM_SHA256
« TLS_ECDHE_RSA_WITH_AES_256_CBC_SHA384
« TLS_ECDHE_RSA_WITH_AES_128_CBC_SHA256
« TLS_RSA_WITH_AES_256_GCM_SHA384

« TLS_RSA_WITH_AES_128_GCM_SHA256

« TLS_RSA_WITH_AES_256_CBC_SHA256

« TLS_RSA_WITH_AES_128_CBC_SHA256

« TLS_RSA_WITH_AES_256_CBC_SHA

« TLS_RSA_WITH_AES_128_CBC_SHA

2" Note: Minimum SSL version

These Max Compatibility security level cipher suites have a minimum required SSL version of TLS 1.0.
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Creating And Installing Custom Certificates

This section describes how to replace Teradici's default certificates with your own custom
certificates.

/" Note: These procedures use OpenSSL

The procedures in this section use OpenSSL to create private keys, certificate signing requests, and certificates. To
use OpenSSL, install Visual C++ 2008 Restributables and Win32 OpenSSL Light v1.0.2g+.

For detailed information about OpenSSL, refer to OpenSSL documentation.

To replace Teradici's default certificates with custom certificates:

—_

. Install required OpenSSL components on your system.

2. Create the internal root CA certificate.

3. Create a private key and certificate pair for the PColP Agent.
4. Configure the certificate mode for each desktop.

5. Install the internal root CA in your PColP clients.

Installing OpenSSL Requirements
Install the following components on your Windows machine:

+ Visual C++ 2008 Redistributables
+ Win32 OpenSSL v1.0.2g Light (or later).

When prompted during OpenSSL installation, copy the OpenSSL DLLs to the OpenSSL binaries
directory; for example, C:\OpenSSL-Win32\bin.

/" Note: Examples use the default installation directory

The following examples assume the default OpenSSL installation directory: C: \OpenSSL-Win32.
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Creating the Internal Root CA Certificate

Creating the Internal Root CA Certificate

This section shows how to create a root CA private key, how to use this key to self-sign and
generate an internal root CA certificate, and how to add X.509 v3 extensions to a certificate that

restrict how the certificate can be used.

Creating a Root CA Private Key
To create a root CA private key in RSA format:

1. Open a command prompt and navigate to the OpenSSL binaries directory (c: \OpenSSL-

Win32\bin).

2. Type openssl and press Enter tolaunch OpenSSL.

/" Note: OpenSSL may need help finding the .cfg file

If you see the following error, you will need to set the OPENSSL_CONF variable before proceeding.

WARNING: can’t open config file: /usr/local/ssl/openssl.cnf

3. To create 3072-bit root RSA key named rootCA.key, use one of the following commands:

+ For an unsecured key, type:
genrsa -out rootCA.key 3072

- For a password-protected key, add the -des3 argument:
genrsa -out rootCA.key 3072 -des3

Password-protected keys require the password to be entered each time they are used.

Caution: Store your private root key in a safe location

Anyone with access to your private root key can use it to generate certificates that your PColP clients will accept.
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Setting the OPENSSL_CONF variable

Setting the OPENSSL_CONF variable

If OpenSSL is unable to find its configuration file, you may need to set the OPENSSL_CONF
variable.

To set the OPENSSL_CONF variable:
1. Exit OpenSSL.
2. Type the following command:

set OPENSSL_CONF=C:\0penSSL-Win32\bin\openssl.cfg

3. Type ssl and press Enter to continue with the step you were performing when you saw the
error.

Self-signing and Creating the Internal Root CA Certificate

Now that we have our private key, we will use it to generate a self-signed X.509 root CA certificate
called rootCA.pem that is valid for 1095 days (1095 days is three years, ignoring leap days).

To create the root CA certificate:

1. Type the following command. This example creates a certificate that is valid for 3 years (1095
days). Change the -days parameter to customize the certificate lifetime:

req -x509 -new -nodes -key rootCA.key -days 1095 -out rootCA.pem

An interactive script will run, which prompts you to enter values for several fields.

2. Follow the prompts to enter field values:

Field Notes

Country Name Optional. Use one of the ISO 3166-1 alpha-2 country codes.
State or Province Optional
Name
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Creating a Private Key and Certificate for the PColP Agent

Field Notes

Locality name Optional
Organization Name Optional
Common name Required. Enter a name for your root CA (for example,

certificates.mycompany.com)

Email address Optional. Enter an administrative alias email if you use this field.

2" Note: Field values can be templatized

If you will be creating a lot of certificates, consider using a configuration file that contains global field values. See
http://www.openssl.org/docs for more information.

Creating a Private Key and Certificate for the PColP Agent

For each PColP Agent instance, you will create three items:

- A private key file
- A certificate signing request (CSR)

A certificate

You will also need an X.509 v3 extension file, which is used as an input when generating the
workstation certificate.

/" Note: There are two different private keys

The private key you create here is used by the PColP Agent to decrypt data. It is different from the internal root
CA private key.

Creating an X.509 Version 3 Extension File

X.509 Version 3 extensions restrict how certificates can be used.
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To create the X.509 v3 extension file;

1. Using a text editor, open a new file and paste the following text into it:

authorityKeyIdentifier=keyid, issuer

basicConstraints=CA:TRUE

keyUsage=digitalSignature, nonRepudiation, keyEncipherment, dataEncipherment
subjectAltName=email : test@mycompany.com

2. Save the file with an .ext extension (for example, v3.ext).

3. Storethefileinthe C:\OpenSSL-Win32\bin directory.

/" Note: More about X.509 v3 extensions

For more information about X.509 v3 certificate extensions, see https://www.openssl.org/docs/apps/
x509v3_config.html.

Creating the Private Key and Certificate
To create the PColP Agent's private key, certificate signing request, and certificate:

1. Launch openssl from the C: \OpenSSL-Win32\bin directory.

2. Create a 3072-bit private key in RSA format:
genrsa -out pcoipprivate.pem 3072

This command creates a pcoipprivate.pem file in the current directory.

3. Create a certificate signing request:
req -new -key pcoipprivate.pem -out pcoip_req.csr

This command initiates an interactive script that prompts you to enter certificate metadata.
You may be prompted for a challenge password and company name.

The Common Name field must be the fully-qualified domain name (FQDN) of the desktop where
the PColP agent is installed for example, mypcname .mydomain.local. If you want to use
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Creating the Private Key and Certificate

the same certificate on multiple machines in the same domain, use a wild card for all but the
last two segments of the FQDN: * .mydomain.local.

When finished, this command creates a pcoipprivate.pem file in the current directory.

4. Sign and create an X.509 v3 certificate. This example creates a certificate valid for one year
(365 days). To customize the certificate lifetime, change the -days parameter:

x509 -req -outform PEM -in pcoip_req.csr -extfile v3.ext -CA rootCA.pem -
CAkey rootCA.key -CAcreateserial -sha256 -out pcoipcert.pem -days 365

This command creates a poipcert.pem file in the current directory.

Caution: Use Secure Hash Algorithms

Windows Certificate Manager has deprecated the use some older hash algorithms such as MD4, MD5, and
SHAT. Use SHA-384 or SHA-256 when creating your certificates.

5. Create a PKCS#12 file to import into a Windows certificate store. Replace <password> with
your password:

pkcs12 -export -in pcoipcert.pem -inkey pcoipprivate.pem -name PCoIP -out
pcoipagent.p12 -password <password>

This command creates a pcoipagent.pl2 file in the current directory.

/" Note: The -name parameter must be 'PColP'

You must specify PCoIP asthe -name parameter value. This value sets the certificate's friendly name.

6. Place the pcoipagent.pl2 and rootCA.pem files where administrative users of the PColP
Agent can access them, such as on network storage or on a USB key.
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Installing the Private Key and Certificate on the
PColP Agent Desktop

The agent certificate and signing certificate must be installed on each desktop running a PColP

Agent.

To install the agent certificate and signing certificate:

1. Open the Microsoft Management Console on the agent machine:

a.

Press + r to open the run dialog

b. type mmc and press (Enter .

2. Add the Certificates snap-in:

a.
b.
C.
d.

€.

Select File > Add/Remove Snap-in.

Select Certificates from the Available snap-ins list and click Add.
Select Computer account and click Next.

Select Local computer and click Finish.

Click OK.

3. Add rootCA.pemto the's Trusted Root Certification Authorities list:

a.

b.

e.

f.

Expand Certificates (Local Computer).

Right-click Trusted Root Certification Authorities, select All Tasks > Import from the context menu,
and click Next.

Use the Browse button to navigate to the directory where the rootCA. pem file is located.
Select All Files (*.*) from the File name drop-down list, and select the rootCA . pem file.
Click Open, Next (twice), and Finish.

Click OK to close the The import was successful message.

4. Add pcoipagent.pl2 to the Personal store of the agent's computer account:

a.

b.

Expand Certificates (Local Computer).

Right-click Personal, select All Tasks > Import from the context menu, and click Next.
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c. Select **Personal Information Exchange (.pfx;.p12)** from the File name drop-down list,
and select the pcoipagent.pl2 file.

d. Click Open and Next.
e. Type the certificate password.
f. Ensure these settings are correct:
« Mark this key as exportable... is enabled
» Include all extended properties is enabled

g. Click Next twice and Finish.

Iy

. Click OK to close the The import was successful message.
5. Restart the PColP Agent service on the workstation:

a. Open Control Panel and select Administrative Tools.

b. Double-click Services.

c. Select your PColP Agent service in the Services list.

d. Click Restart the service.
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Installing the Internal Root CA Certificate in a PColP
Client

Your root CA certificate must be installed in any PColP client that will be used to connect to the
PColP Agent.

Installing Root CA Certificates on a Zero Client

Zero clients are managed via an Administrative Web Interface (AWI) and accessed using a web

browser. Supported browsers are:

« Firefox 46

« Chrome 60

* Internet Explorer 11

+ Microsoft Edge 25

/" Note: Browser must support TLS

Web browsers must support TLS 1.1 or later to connect to the zero client's Administrative Web Interface.

To upload the root CA certificate to a zero client:

1.

From a supported browser, enter the IP address of the zero client and log in to its
Administrative Web Interface.

Select the Upload > Certificate menu to display the Certificate Upload page.

In the Certificate filename field, click Browse, and then navigate to the directory that contains
your root CA certificate.

Select your root CA certificate (* . pem) and then click Open.
Click Upload and then OK.

Click Continue.
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If the certificate uploads successfully, it will appear in the Uploaded Certificates section on this
page.

Installing Root CA Certificates on a Mobile Client

Before you can install the root CA certificate in a PColP Mobile Client, you must change the file
extension from .pemto .crt.

The . pem extension is used for different types of X509 v3 files that contain ASCIl Armor (Base64)
data prefixed with a "--—--BEGIN" line. The . crt extension is used for certificates that may be
encoded either in binary DER format or ASCII PEM format.

Installing Root CA Certificates in the PColP Software Client for macOS

& Important: Root CA Certificate must have a .crt extension

You must change the root CA certificate's extension from . pemto . crt before installing it on a PColP Software
Client.

In macOS, certificates are stored in the Keychain Access application.
To import your root CA certificate in the PColP Software Client for macOS:

1. Copy your root CA certificate file (*.crt) to the Mac client desktop.
. Double-click Applications > Utilities Keychain Access.app to open Keychain Access.

. Select File > Import Items.

2

3

4. Navigate to the desktop and then select your root CA certificate.

5. In the Destination Keychain drop-down menu, select System, and then click Open.
6. If prompted, enter your Keychain Access password and then click Modify Keychain.
7

. At the next screen, click Always Trust when asked whether you want your computer to trust
certificates signed by this certificate.

8. If prompted, enter your Keychain Access password and then click Update Settings.

After the certificate installs successfully, it appears in the System > Certificates list.
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Installing Root CA Certificates in the PColP Software Client for Windows

6 Important: Root CA Certificate must have a .crt extension

You must change the root CA certificate's extension from .pemto . crt before installing it on a PColP Software
Client.

/" Note: Windows must trust your root certification authority

When you use your own private key and certificate, you must add your internal root CA certificate to the Windows
Trusted Root Certification Authorities certificate store on the client computer.

Users without a trusted root CA will receive an Unable to get local issuer certificate error and fail to connect.

/" Note: Active Directory group policies

For information on using Active Directory Group Policy to distribute certificates to client computers, see http://
technet.microsoft.com/en-us/library/cc772491.aspx.

To import the root CA certificate for the PColP Software Client for Windows:

1. Copy your root CA certificate file (*.crt) to a directory reachable by your Windows client.
2. Open the Microsoft Management Console on the agent machine:
a. Press + r toopen the run dialog
b. type mmc and press Enter .
3. Add the Certificates snap-in:
a. Select File > Add/Remove Snap-in.
b. Select Certificates from the Available snap-ins list and then click Add.
c. Select My user account and then click Finish.
d. Click OK.
4. Import the root CA certificate:

a. Expand Certificates - Current User.
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Installing in a PColP Mobile Client

b. Right-click on Trusted Root Certification Authorities, select All Tasks > Import from the context
menu, and then click Next.

c. Use the Browse button to navigate to the directory where your root CA certificate is
located and select your root CA certificate.

d. Click Open and then Next.

e. Select the option to place all certificates in the Trusted Root Certification Authorities
certificate store.

f. Click Next and then Finish.

g. At the security warning, click Yes.

After the certificate installs successfully, it appears in the Trusted Root Certification Authorities >
Certificates list.

Installing in a PColP Mobile Client

To install your internal root CA certificate on an iOS, Android, or ChromeOS device, consult the
documentation for your device. The PColP Mobile Client software does not implement certificate
installation.

Veritying Certificate Formats

If you have OpenSSL installed on your system, you can use it to verify that your root CA certificate
is in ASCIl PEM format.

To verify that the root CA certificate is in ASCII PEM format:

1. Launch openssl from the C: \OpensSSL-win32\bin directory.

2. Type the following command:

x509 -in rootCA.pem -text -noout

If your certificate contents successfully display on the screen, it is encoded correctly as a PEM file.
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Configuring the Agent Certificate Mode

The PColP Agent chooses a certificate based on the parameters set in the Configure PColP
Security Certificate Settings GPO variable.

Since PColP agents automatically generate and use self-signed certificates by default, you only
need to configure the Configure PColP Security Certificate Settings GPO variable if you are
deploying your own custom certificates.

You can configure PColP AGents to handle certificates in the following ways:

- Always use self-signed certificates (default)
- Always use local custom certificates

-+ Attempt to use a local certificate, and revert to self-signed if not found

/" Note: Import the administrative template file before configuring

The Configure License Server Path GPO variable only appears in the GPO editor after you import the administrative
template file.

The example in this section configures the agent to look for the certificate only in the remote
workstation's Windows certificate store. The example also gives the store the friendly name of
"PColP". These settings are mandatory when you deploy your own custom certificates.

To configure the Configure PColP Security Certificate Settings GPO variable with a custom certificate:

1. Open the Local Group Policy Editor on the agent machine:
a. Press + r to open the run dialog
b. type gpedit.msc and press Enter |

2. Navigate to Local Computer Policy > Computer Configuration > Administrative Templates >
Classic Administrative Templates (ADM) > PColP Session Variables > Not Overridable
Administrator Defaults

3. Double-click Configure PColP Security Certificate Settings to open the variable's dialog.

4. Select Enabled to enable the setting.
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5. In the How the PColP agent chooses the certificate... drop-down list, select From the Certificate
Store.

In The minimum key length... drop-down list, select the desired minimum key length (in bits).
Click OK.

Close the Local Group Policy Editor and reboot the desktop to apply your settings.

© © N o

After the PColP agent restarts, you can verify that it is using your custom certificate by
checking the agent's level 2 log files.
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Supported Installer Languages

The Remote Workstation Card Agent for Windows installer supports the following languages:

+ French

+ German

+ Spanish

+ Simplified Chinese
« Traditional Chinese
+ Japanese

* Portuguese

+ Italian

+ Korean

* Russian

+ Turkish
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Enable Software Secure Attention Sequence (SAS)

Enable Software Secure Attention Sequence (SAS)

{!'../../common/windows/reference/enable-sas.md '}
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Contacting Support

If you encounter any problems installing, configuring, or running the Graphics Agent, you can
create a support ticket with Teradici.

Before creating a ticket, be prepared with the following:

+ A detailed description of the problem
- Your agent version number (how do | find my version number?)

+ A prepared support file

The Teradici Community Forum

The PColP Community Forum enables users to have conversations with other IT professionals to
learn how they resolved issues, find answers to common questions, have peer group discussions
on various topics, and access the Teradici PColP Technical Support Service team. Teradici staff
are heavily involved in the forums.

To visit the Teradici community, go to https://communities.teradici.com.
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Finding the Agent Version Number

Finding the Agent Version Number

You can find your PColP Agent's version number using the Windows Control Panel.

To find your agent's version number:

1. Open the Windows Control Panel, and navigate to Uninstall a program.

2. Find the PColP agent type and version number in the program list.
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Creating a Technical Support File

Teradici may request a support file from your system in order to troubleshoot and diagnose PColP
issues. The support file is an archive containing PColP Remote Workstation Card Agent for
Windows logs and other diagnostic data that can help support diagnose your problem.

You can create a support file using the PColP control panel. If the PColP control panel is disabled,
you can also run the bundling application directly using Windows Explorer or from the command
line.

Both methods place a support bundle in the Teradici Support folder, located at C:

\ProgramData\Teradici\Support.

To create a support file with the PColP Control Panel:

1. Open the PColP Control Panel L1 inthe system tray.
2. Select the Support tab and then click the Create Support File button.

3. When the zipped support file is ready, an Explorer window opens and displays your Teradici
Support folder. The generated file is selected.

To create a support file with the bundling application:

1. Using Windows Explorer or a command line tool, navigate to C: \Program
Files\Teradici\PCoIP Agent

2. Run SupportBundler.exe.

3. When the zipped support file is ready, an Explorer window opens and displays your Teradici
Support folder. The generated file is selected.
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Performing Diagnostics

Each PColP component creates and updates a log file which records its activity as the system is
used. Most troubleshooting within a PColP system begins by examining these log files and looking
for error conditions or other indications that may explain why the system is not operating as

expected.

Log files for the and other Teradici PColP components are saved to log directories.

The Windows Event Viewer also contains PColP event logs for high-level events.

2" Note: Bundling log files for support

When investigating issues with Teradici support, you may need to provide a support file which includes system log

files. Instructions are provided here.
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Locating Agent Log Files

Log files for the PColP agent are located in the following directories by default. If you changed your
agent's location during installation, the log files will be in your custom location instead.

Component Log file location

Remote Workstation Card Agent for $programdata%\Teradici\PCoIPAgent\logs
Windows
PColP Server PCoIP Server%programdata$

\Teradici\PCoIPAgent\logs

/" Note: Bundling log files for support

When investigating issues with Teradici support, you may need to provide a support file which includes system log
files. Instructions are provided here.
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Setting Log Levels

Each PColP component is configured to log events. The amount of information captured can be
configured by setting the log verbosity on a scale from 0 (least verbose) to 3 (most verbose). By
default, the Remote Workstation Card Agent for Windows records log events at level 2.

When troubleshooting a particular problem, Teradici Support Services may recommend adjusting

the log level for specific components to obtain more information from certain parts of the system.

To change the verbosity level, specify a new Event Filter Mode setting. For help changing agent
configuration settings, see Configuring the Remote Workstation Card Agent for Windows.
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Session Log IDs

At the start of each PColP session, a unique session ID is generated by the PColP Client and
passed to all connected PColP components (including the agent). Log messages generated by the
agent are prefixed with this session ID, making it easy to identify All log messages generated
during a single session, by any PColP component, will be prefixed with the same session log ID in
RFC-4122 format:

yyyy-mm-ddThh:mm:ss. ffffffZ XXXXXXXX=XXXX=XXXX=XXXX~XXXXXXXXXXXX > ..
For example:
2015-11-06T08:01:18.688879Z 4208fb66-€22a-11d1-a7d7-00a0c982c00d > ..

Log messages that do not pertain to a specific session will show a string of zeroes in place of the
session log ID number.

If a PColP component does not receive a session log ID from the PColP client, or receives an
invalid value, it will generate a new session log ID and distribute it to the other components in the
system.
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Viewing Windows Event Viewer PColP Agent Logs

You can view high-level session and connection events generated by the PColP agent and Cloud
Access Manager in the Windows Event Viewer.

PColP Agent Events

To view events using the Windows Event Viewer:
1. Navigate to Start > Control Panel > System and Security > Administrative Tools and double-
click Event Viewer.

2. Navigate to Event Viewer (Local) > Windows Logs, right-click Application, and select Filter
Current Log.

3. In the Event sources drop-down list, select PColPAgentService and click OK.

4. Select an event to view its details.

The next example shows typical PColP agent session and connection events that you can view in
the Windows Event Viewer.
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Application

Number of events: 8,957

PColP Agent Events

“¥  Filtered: Log: Application; Source: PColPAgentService. Number of events: 96

Level Date and Time Source EventID Task Category “*
@Information 2/4/2016 10:47:03 AM PColPAgent... 88 None -
(i) Information 2/4/2016 10:45:32 AM PColPAgent... 89 None -
@Information 2/4/2016 10:44:08 AM PColPAgent... 88 None B
(i) Information 1/25/2016 4:45:03 PM PColPAgent... 95 None
(i) Information 1/25/2016 4:43:09 PM PColPAgent... 89 None
@Information 1/25/2016 3:49:37 PM PColPAgent... 88 None
(i) Information 1/22/2016 10:09:50 AM PColPAgent... 95 None
@Information 1/12/2016 12:25:27 PM PColPAgent... 83 None
(i) Information 1/11/2016 11:16:52 AM PColPAgent... 88 None
(i) Information 12/22/2015 10:46:00 AM PColPAgent... 89 None
(i) Information 12/21/201510:03:11 AM PColPAgent... 88 None
(i) Information 12/17/2015 6:55:59 PM PColPAgent... 89 None
(i) Information 12/17/2015 4:15:47 PM PColPAgent... 88 None
@Information 12/17/2015 4:15:26 PM PColPAgent... 95 None
(i) Information 12/17/2015 4:14:30 PM PColPAgent... 96 None
(i) Information 12/17/2015 4:01:37 PM PColPAgent... 89 None -
Event 88, PColPAgentService X
General | Details
Session cc3effd2-ebf7-42e4-8172-8f14f7474aaa is starting. B
Log Name: Application [
Source: PColPAgentService Logged: 2/4/2016 10:47:03 AM
Event ID: 88 Task Category: None T
Level: Information Keywords: Classic
User: N/A Computer: JWTWAS23 terase.local L

Key events to watch for in the event viewer logs:

88 SESSION_START
89 SESSION_END
90 LAUNCHER_EXIT
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92

93

94

95

96

97

98

99

100

101

102

103

104

105

112

113

CONNECTION_TIMEOUT

CONNECTION_FAILURE

SESSION_REDIRECTION

SESSION_INTERRUPTION

SERVICE_STARTING PColP

SERVICE_STOPPING PColP

SESSION_RESUMING

VIDEO_DRIVER_REPAIR_ERROR

FLEXERA_SERVICE_ERROR

VCHAN_LOADER_EXCEPTION

NO_AGENT_ERROR

VCHAN_LOADER_INTERNAL_ERROR

VCHAN_LOADER_BAD_INVOCATION_ERROR

AGENT_PROCESS_TERMINATED_ERROR

SSO_PIPE_CREATION_ERROR

SERVICE_START_ERROR PColP

SERVICE_INTERNAL_ERROR
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Agent service starting.

Agent service stopping.

An exception was thrown in a PColP virtual channel
plugin.

The PColP agent process could not be detected.

An internal error has occured.

The PColP virtual channel loader utility was invoked
incorrectly.

The PColP Agent process was terminated.

The Single Sign On framework was unable to establish
a secure connection with the Teradici Agent.

Agent service cannot be started.
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Cloud Access Manager Events

114 SERVICE_ADMINISTRATIVE_MESSAGE

Cloud Access Manager Events

If you are using Cloud Access Manager to start and stop your host machines, the
CAMIdleShutdown process will log events as well. Follow the same procedure

Event ID Description

95 CAM Idle Machine Shutdown service starting
96 CAM Idle Machine Shutdown service stopping
114 Machine will be checked for idle state.
115 Shutting down idle machine.

© 2019 Teradici

49



Troubleshooting License Issues

Troubleshooting License Issues

Teradici includes license troubleshooting utilities with the Remote Workstation Card Agent for
Windows. These utilities allow you to validate your licenses and list license entitlements.

Validate Licenses

pcoip-validate-license scans your local system and any connected physical or cloud-based
license servers for active licenses, and lets you know when your license subscription expires. For
more information, see Welcome to Cloud Licensing.

To run the license validation tool, open a PowerShell window, navigate to the PColP Agent
directory, and type:

.\pcoip-validate-license.ps]1
For more detailed instructions, open a PowerShell window and type:

get-help ./pcoip-validate-license.ps]i

List License

pcoip-list-licenses retrieves and displays all license entitlements on a connected physical or
cloud-based PColP license server.

To run the license list tool, open a PowerShell window, navigate to the PColP Agent directory, and
type:

./pcoip-list-licenses.ps]
For more detailed instructions, open a PowerShell window and type:

get-help ./pcoip-list-licenses.ps]
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Managing Session Licenses Using the PColP Control Panel

Managing Session Licenses Using the PColP
Control Panel

You can use the PColP Control Panel to register a license, check the status of a license, and renew

a license.

The PColP Control Panel can be opened using either of these methods:

+ Click &1 in the Windows system tray

+ Open a command line tool and run

C:\Program Files (x86)\Teradici\PCoIP Agent\bin\pcoip_control_panel.exe
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Managing Session Licenses Using the PColP Control Panel

If you have not registered your license already, select the Licensing tab and enter your registration

code, as shown next.

ri PColP Control Panel
Licensing Updates Support

License Status
PCoIP Graphics Agent has no license.

Purchase or Renew

License Reaqistration
Please enter your registration code you received by email from Teradici.

Registration code: |A1BC3D6EY2FVM@A123-4567-890B-CDEF

[] use a proxy server for Internet connection

Address: Port:

Register

X
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Once you are licensed, the tab will show your license subscription expiry information, and enables
you to renew the license.
rf PColP Control Panel X

............................

............................

License Status
Your license is valid until Wednesday, February 7, 2018.

Purchase or Renew
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PColP Remote Workstation Card Agent for
Windows 19.11.0 Release Notes

Release Overview

This release provides support for the PColP Broker Protocol, which allows connections to the
Remote Workstation Card machine to be brokered by Teradici Cloud Access Manager, or by a

third-party broker such as Leostream.

This release contains bug fixes and security enhancements.

Important Notes and Requirements

+ PColP Remote Workstation Card Agent 19.11 for Windows requires a license registration code
(for Teradici Cloud Licensing), or a license activation code (for Local License Servers). If you

are a new user, request a registratration code for a full evaluation.

* You can use either a Cloud Access license or a Cloud Access Plus license to activate your

PColP session.

+ When reporting issues to Teradici, be sure to run the SupportBundler.exe application and

include the output it generates.

Release Downloads and Documentation

+ PColP Remote Workstation Card Agent 19.11 for Windows Documents and Downloads

+ Open-source and third-party components

Resolved Issues

None.
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Known Issues

Known Issues

System may crash when uninstalling or upgrading Remote Workstation Card Agent for Windows
on Windows 10 build 1803 and Windows Server 2019 VM (75664)

When uninstalling or upgrading Remote Workstation Card Agent for Windows on an Windows 10
build 1803 or Windows Server 2019 VM, the system may crash.

Workaround:

Reboot the system before uninstalling or upgrading Remote Workstation Card Agent for Windows.

Remote Workstation Card Agent for Windows fails to start (72726)

The Remote Workstation Card Agent for Windows requires port 60443 for proper operation.
Unavailability of this port prevents the agent from starting.

The following Remote Workstation Card Agent for Windows log message can appear: AGENT :
0894 Failed to bind required address ssl://127.0.0.1:60443: Cannot bind to port

Workaround:
Reboot the machine.
Remote Workstation Card Agent for Windows refuses connection with licensing error (72286)

The Windows Management Instrumentation service can run into a bad state, which prevents
Remote Workstation Card Agent for Windows from checking out a valid license. When this
problem occurs, user will see the "no license" error on the client and should see the following error
message in the Remote Workstation Card Agent for Windows log:

Exception caught ( Error processing FNE capability response: [1,7E2,5,0[7000001B,
0,CO3F9]] Response does not match system hostid. ) while sending a request for
license renewal.

Workaround:

This problem was caused by WMI's inability to get host UUID. When running

wmic csproduct get UUID
Node - TERVDIW1ODEV22
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ERROR:
Description = The paging file is too small for this operation to complete.

The workaround is to restart Windows Management Instrumentation and Remote Workstation
Card Agent for Windows for Windows service in sequence in Control Panel -> Administrative Tools
-> Services. If the services won't restart then restarting Windows will resolve the issue.

First connection fails to connect after Windows update (72776)

After initiating certain Windows Updates, the update process may not complete until a user
attempts to logon. In these situations the PColP session will fail to establish while the Windows
Updates completes and the WDDM driver is re-configured.

Subsequent connection attempts after the Windows Updates completes are successful.
Workaround:

Attempt to login via PColP after a Windows 10 update. If the connection fails, then wait a few
minutes for Windows Update to complete and for the Remote Workstation Card Agent for
Windows to restore its compoents and then re-connect.

Installation timeout in Windows 7 when system restore is enabled (67818)

If system restore is enabled, Remote Workstation Card Agent for Windows installation on windows
7 platform might fail due to time out.

Workaround:
Disable system restore
Windows CardSpace interferes with PColP (66833)

On Windows 7 and Windows Server 2008R2 there is a Microsoft feature to support digital
identification called Windows Cardspace. Use of this feature will freeze your PColP session and
prevent future connections.

Workaround:

If you are unable to connect to your PColP session due to launching Windows Cardspace then you
can connect to your virtual machine using RDP and close Windows Cardspace to re-enable PColP
connectivity.
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Cloud Access Software indicates no license (66566)

Connection via PColP can fail stating a lack of license even though the system is properly
licensed. Additionally, issuing the pcoip-validate-license.ps1 command can fail resulting in a crash
dump.

Workaround:
Rebooting the VM can restore proper licensing functionality.
PColP validate license reports unsupported version of Trusted Storage (66075)

When executing pcoip-validate-license on either Windows or Linux an error is reported stating that
This version of trusted storage is not supported.

Workaround:
1. Delete the contents of C:\ProgramData\Teradici\PColPAgent\licensing\5 in Windows, or /var/
lib/pcoip-agent/licensing/5 (requires root permissions) in Linux

2. Restart the appropriate agent service (PColP Graphics Agent or PColP Standard Agent on
Windows, or pcoip-agent on Linux)

3. If using Teradici Cloud Licensing (not using a local license server), re-register the host.
Licensing can fail if Windows WMI infrastructure is impaired (65660)

Windows infrastructure failures can prevent Remote Workstation Card Agent for Windows
licensing to be acquired. If the Remote Workstation Card Agent for Windows is not licensed, the
user will not be able to connect to the remote machine.

Workaround:

Rebooting the machine may resolve the WMI impairment, enabling PColP licensing to be
successfully acquired.

Operating system re-installation requires re-installation of PColP Remote Workstation Card
Agent for Windows (54456)

Upgrading from Windows 10 to Windows 10 Anniversary Update (1607) performs an operating
system re-install. After re-installing Microsoft Windows, only some device drivers are migrated to
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the new operating system. Since not all of the PColP Remote Workstation Card Agent for Windows
software is migrated, it will need to be re-installed.

Performance counters do not appear to collect data (45092)

In some cases, even though the performance counters have been installed correctly, it may appear
as if they are not collecting data. This occurs due to the fact that the user may have opened the
64-bit version of the performance monitor, while Teradici's performance counters are 32-bit only.
As the counters cannot be loaded into the 64-bit version, Windows will disable data collection. A
corresponding message in the Windows Event Log should indicate this as well.

Workaround:

To solve the issue: 1. Click Start, click Run, type emd, and then click OK. 2. Type the following
command, and then press Enter. mmc.exe /32 perfmon.msc . This command runs System Monitor
in 32-bit emulation mode. 3. Use System Monitor to determine whether the performance counter
object is available.

System volume set to maximum after agent upgrade (42226)

When upgrading to the latest Remote Workstation Card Agent for Windows, audio volume is
automatically set to maximum.

Workaround:

Manually set the audio to the desired volume after upgrading. Once set manually, the audio volume
is maintained. The change in audio volume only happens at upgrade.

Remote Workstation Card Agent for Windows fails to connect when host has multiple NICs
(40825)

When a host computer has more than one network adapter, the system must be configured to
inform which adapter to use for inbound PColP connections. You can do so by populating the
PColPConnectionAddress registry value with your desired network interface.

Some software applications such as Npcap can create a virtual network adapter that will present
additional Ethernet adapters. These configurations also require populating the
PColPConnectionAddress registry value with your desired network interface.

Workaround:
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In HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Teradici\PCoIPAgent , set the
PCoIPConnectionAddress registry value:

"PColPConnectionAddress'="a.b.c.d"

Where a.b.c.d is your desired network interface). The type of the reg key is a string value: REG_SZ.

Agent installation may take a long time (22702)

Teradici installs Microsoft Visual Studio 2013 C/C++ runtimes as part of the agent installation.
Runtime installers create a system restore point which, on systems such as Windows 8, can take
over 15 minutes. If the installer appears to be stalled when installing the C/C++ runtimes, it may
simply be the runtime installers creating a system restore point.
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Frequently Asked Questions

Can | use a screensaver?

Yes. However, a blank, static screensaver will provide the most efficient CPU ane network
bandwidth usage.

How quickly does a PColP agent complete a connection?

PColP agents can usually achieve a connection in 15 to 30 seconds. Teradici uses the statistical
value Top Percentile (TP) to measure the time to establish a session:
+ TP99: Ninety-nine percent of connections complete in under 30 seconds.

+ TP50: Fifty percent of connections complete in under 15 seconds.

What do | need to know about power management?

Hosts with Windows power management enabled may drop PColP connections when turning off
displays or going to sleep. If this behavior is undesirable, these Windows power management
features should be turned off.

To disable Windows power management features:

1. From the Windows Control Panel, open Power Options.
Click Change plan settings next to the enabled power plan.
Select Never from the drop-down list for Turn off the display

Select Never in the drop-down list for Put the computer to sleep.

a > w0

Click Save changes.

Why is my application not sending audio?

The PColP agent delivers audio over PColP connections by reassigning the system's default audio
device. Only applications that use the system default audio device will send or receive audio over
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I'm using Teradici Cloud Licensing. What network blocks should | leave open?

PColP; applications that are configured to use non-default devices will not work. If you don't hear
audio from your application, make sure it is configured to use the system default audio device.

I'm using Teradici Cloud Licensing. What network blocks should | leave open?
If you are using Teradici Cloud Licensing, you will need to whitelist the following:

- teradici.flexnetoperations.com

+ teradici.compliance.flexnetoperations.com
Alternatively, you can also ensure the following network blocks are whitelisted:

* Production: 64.14.29.0/24
- Disaster Recovery: 64.27.162.0/24

The following network blocks are not currently in use, but may also be used in the future:

* Production: 162.244.220.0/24
- Disaster Recovery: 162.244.222.0/24
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